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Chapter 1
Getting Started with Verify

About Verify
Verify is designed for PCB fault verification and test fixture debugging. The power of Verify is that it
takes the fault data from your tester (i.e., coordinates of grid points, test point numbers, row and
column locations, etc), and then Verify matches that information with the corresponding test points and
pads in the PCB data. On a graphical representation of the PCB, Verify displays the test points in
question and highlights the affected nets, making it easy to identify the elements to be tested for
verification. For shorts, Verify can also run a proximity check between the two nets to identify
probable fault areas. With Verify, you can:

Open the FixMaster/ProbeMaster Job File
Verify can import all data saved in the FixMaster or ProbeMaster job file. This includes the PCB
database, and the tester-specific information. Verify uses this information to match fault data from the
tester to the PCB data.

Set up a Verification Points Table
You can set up a table of fault points identified by the tester as shorts or open points. For some tester
error file formats, you can import the fault data in a file. And you can also enter the fault data
manually.

Configure a Proximity Check
You can set up a pad-to-pad, trace-to-trace, and trace-to-pad proximity check that is run on shorted
nets. The proximity check finds probable fault areas where the two nets may be shorted, elements that
are close to each other in the two nets. Verify highlights these probable fault areas on screen.

Control the Display of the Imported Data
Verify allows you to control what is shown on screen. You can display the top, bottom, and inner
layers of the PCB data independently or together, and you can turn on or off the display of soldermask,
silkscreen or board outline data. You can turn on and off the display of tester-specific data such as
fixture drills, fixture grid points, fixture pins, wire wrap path, or moving probe fiducials. You can turn
on and off the display of test point numbers and net numbers.

Examine the Error Data
Verify gives you several commands for inspecting the representation of the fault data on screen. You
can display errors one at a time and select which verification points to turn on and off. There are
commands to go to each verification point sequentially. For nets that have verification points
displayed, Verify highlights the whole net, shows its traces and displays its net number next to its test
points. For shorts, Verify runs a proximity check and color-codes probable fault areas. There are
commands to go to each proximity check violation.
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Send Us Your Comments
Lavenir is committed to continuous improvement. Your constructive comments on Verify will help us
to correct problems and improve features.

• Please e-mail your comments and suggestions regarding Verify to
feedback@lavenir.com.

• Visit the Lavenir Web Site at http://www.lavenir.com.

• You can reach Lavenir Technical Support at (925) 680-7400 between the hours of 8 AM and
5 PM Pacific Time.

• Lavenir is located at:
2440 Estand Way
Pleasant Hill, CA   94523

Lavenir Technical Support
You can reach Lavenir Technical Support by:

• Telephone: (925) 680-7400 between the hours of 8 AM and 5 PM Pacific Time.

• E-Mail: support@lavenir.com.

• Web Site:  http://www.lavenir.com

Contact Lavenir Customer support with questions about Lavenir hardware and software or to arrange
for training or maintenance.

Lavenir is located at:

2440 Estand Way
Pleasant Hill, CA   94523
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Download Software Updates
Lavenir makes updated versions of Verify and updated Help files available to customers who have a
current maintenance agreement or warranty. You can download the current Verify updates from the
Lavenir Premier Support Web site.

To Download Verify Updates:
1. Have your User Name and Password ready before logging on to the Lavenir Premier Web

Site. Your User Name and Password are printed on your User Password Letter. If you do not
know your User Name and Password, call Lavenir at (925) 680-7400.

2. Go to the Lavenir Web Site at http://www.lavenir.com.

3. On the Site Map, click on Premier Support.

4. On the User Name and Password dialog, enter your User Name and Password.

5. Click on Software Library .

6. Follow the instructions to download the VERIFY SETUP.EXE  update file to your system.

7. Double-click on the downloaded VERIFY SETUP.EXE  file on your system and follow the
setup instructions.
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Chapter 2
How to Verify Fault Data Using Verify

This chapter contains a step-by-step outline of the fault verification process in Verify. And it also
contains detailed procedures for most of the steps in that outline.

Fault Verification Step-by-Step Outline
Fault verification in Verify is a simple process in general, but the exact details of the procedure you
use depend a lot on the type of tester you use. This procedure provides a general outline you can use to
define your own procedures.

Fault Verification Procedure:
1. Open the FixMaster/ProbeMaster Job File. The .JOB file contains the PCB information

that Verify will match to the tester fault information. See Opening the
FixMaster/ProbeMaster Job File on page 6.

2. Set up the Proximity Parameters. The proximity check identifies areas in shorted nets
where the shorts may have occurred. See Setting up Proximity Parameters on page 7.

3. Set the Tester Error File Format. The selected tester error file format controls many of the
options available later in this procedure, so it is very important to do this before entering the
verification points. See Setting the Tester Error File Format on page 8.

4. Enter the Verification Points. Verify uses the verification points from the tester to display
the faults on screen. See Entering Fault Data on page 9.

5. Set up the Verification Points Table Settings to Interpret the Verification Points
Properly. For some tester error file formats, Verify needs additional information to interpret
the verification points properly. See Setting the Verification Points Table Settings to Interpret
Points Properly on page 20.

6. Examine the Faults. Verify has many features to help you locate the points on the board that
need to be verified. See Examining Faults on page 24.
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Opening the FixMaster/ProbeMaster Job File
The first step in the fault verification process is to open the FixMaster or ProbeMaster .JOB file that
was used to prepare the test files for the boards you are going to verify. The .JOB file contains the
original PCB information that was imported into FixMaster or ProbeMaster. It also contains the
database that matches the imported PCB design and test points to the tester locations (i.e., fixture grid
points, wire wrap translation blocks, or moving probe test points). Verify will use this information to
translate the fault locations reported by the tester back into a graphical representation of the fault
locations on the PCB design.

To Open the FixMaster/ProbeMaster Job File:
1. On the File menu, click Open.

2. In the Look in box, click the drive, folder, or network location that contains the .JOB file.

3. In the folder list, double-click folders until you open the folder that contains the .JOB file you
want.

4. Double-click the .JOB file.

Tip: To open a .JOB file you've used recently, click the file name on the Recent Files List at
the bottom of the File menu.

Menu: File-Open

Button:

Key: Ctrl+O
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Setting up Proximity Parameters
To help find shorts between nets, Verify has a Proximity Check feature. The Proximity Check finds
elements in the shorted nets that are closer than the minimum distance you enter. This feature locates
elements in shorted nets that are close together and helps pinpoint areas on the board where the short
may have occurred.

To set up the Proximity Check:
1. On the Config menu, click Proximity Check.

Verify displays the Proximity Check dialog.

Proximity Check Dialog

2. In the Minimum Distance group box, enter the minimum distance allowed between elements.
Elements that are in shorted nets and are closer than the minimum distance are considered to
be proximity violations.

3. In the Max Trace Count field, enter the maximum size of nets to check. Verify will not
check nets that have more than the maximum number of traces.

4. Click OK

Menu: Config-Proximity Check

Button: None

Key: None
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Setting the Tester Error File Format
Depending on the tester error file format selected, Verify changes the options available on certain
dialogs and changes how the program interprets fault data entries. Because of this, it is important to set
the tester error file format before entering the fault data.

To Set the Tester Error File Format:
1. On the Config menu, click Error File Format .

Verify displays the Error File Format dialog.

Error File Format Dialog

2. Select the format of the error file and click OK .

Menu: Config-Error File Format

Button: None

Key: None
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Entering Fault Data
In general, in Verify you can enter the fault data in two ways, import a fault file from the tester or enter
the fault data manually.

Each tester format handles these operations differently. For instance, not all tester formats allow you to
import a fault file from a tester; some formats only allow fault data to be entered manually. And for the
formats that do have the option to import fault files, each format has a different import dialog. In
addition, the manual fault data for each tester format may be in a different form (i.e., test point
numbers for moving probe testers; X, Y grid coordinates for universal testers; and translation hole
numbers for wire wrapping). Because of this variation, it is important to set up the tester type before
entering the fault data. See Setting the Tester Error File Format on page 8.

Importing a Fault File from the Tester
The values in the Verification Points table provide Verify the information it needs to correlate fault
data with the PCB nets. Each tester format handles importing a fault file differently. For instance, not
all tester formats allow you to import a fault file and instead they require you to enter the fault data
manually. And for the formats that do have the option to import fault files, each format has a different
import dialog. Because of this variation, it is important to set up the tester type before entering the fault
data. See Setting the Tester Error File Format on page 8.

To Import a Fault File from the Tester:
1. On the Action Menu, click Input Table .

Verify displays the Verification Points dialog. If the error file format you selected earlier is
Generic, Integri, Viking, LM, ECT9090, TTI, TRACE948, PDI, or FASTEK, the Verification
Points dialog that is displayed looks like the following. For other versions, see the sections
following this procedure.
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Verification Points Dialog used by Most Error File Formats

2. In the Enter Verification Points group box, select the option to Import from Error File .

3. In the Import Error File text box, enter the name of the error file, or click the Browse
button to select a file from the available directories.

4. To import the file into Verify, click the Import File button.

5. After loading the file, set up the other settings on the Verification Points dialog to interpret
the loaded verification points properly. See Setting the Verification Points Table Settings to
Interpret Points Properly on page 20.

Menu: Action-Input Table

Button:

Key: None
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EMMA Verification Points Dialog

EMMA Verification Points Dialog

Note: This dialog can be displayed using the menu command Action-Input Errors-File. The menu
command Action-Input Errors-Manual displays a dialog in which you can enter EMMA
verification points manually.

UTRON Verification Points Dialog

UTRON Verification Points Dialog
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ECT/Custom Kyoei Verification Points Dialog

ECT/Custom Kyoei Verification Points Dialog

Note: The ECT/Custom Kyoei Verification Points Dialog does not provide the option to import a
file. This dialog is the same as the ECT/Custom Kyoei Quick Input Table. See Quick Input
Table on page 13.

Cline/TTI9600 Verification Points Dialog

Cline/TTI9600 Verification Points Dialog
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Entering Fault Data Manually
For most tester error file formats there are two tables where you can enter fault data manually, the
Quick Input Verification Points Table  and the full Verification Points Table. Because the options
available on these dialogs depend on the selected tester error file format, your particular format may or
may not include all of the options discussed. For information on setting the tester error file format, see
Setting the Tester Error File Format on page 8.

Quick Input Table
The quickest way to enter fault data manually is to use the Quick Input Verification Points Table .
For most tester error file formats the Quick Input Verification Points Table allows you to enter pairs
of verification points. This table is used when you want to quickly display one set of faults at a time.

To Enter Fault Data Manually from the Quick Input Verification Points Table:
1. Press the forward slash ( / ) key.

Verify displays the Quick Input Verification Points Table . If the error file format you selected
earlier is Generic, Integri, Viking, LM, ECT9090, Cline/TTI9600, TTI, TRACE948, PDI, or
FASTEK, the Quick Input Verification Points Table  dialog that is displayed looks like the
following. For other versions, see the sections following this procedure.

Quick Input Table

2. In row 1, enter the X and Y locations and the board side of the first verification point, and in
row 2 enter the information for the second point.

Note: If the Quick Input Table does not seem to be accepting data the way you expect (for
instance, data following the decimal point disappears), check the Verification Points
Dialog settings, to be sure they are correct. See Setting the Verification Points Table
Settings to Interpret Points Properly on page 20.

3. Click OK .

Menu: None

Button: None

Key: Forward slash ( / ) key
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EMMA Quick Input Table

EMMA Quick Input Table

Note: The EMMA Quick Input Table can also be displayed using the menu command Action-Input
Errors-Manual. The menu command Action-Input Errors-File displays a dialog in which
you can import an EMMA error file.
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UTRON Quick Input Table

UTRON Quick Input Table

ECT/Custom Kyoei Quick Input Table

ECT/Custom Kyoei Quick Input Table



Verify User’s Guide

16

Full Verification Points Table
The other table where you can enter fault data manually is the full Verification Points Table. On the
full Verification Points Table you can enter all the fault data at one time if you wish and control
which data you want to display at any given time, or you can enter pairs of faults one at a time. For
some tester error file formats, the table also has the ability to import the tester fault data file. See
Importing a Fault File from the Tester on page 9. For some tester error file formats the table also
contains other settings that allow Verify to interpret the fault data properly. See Setting the Verification
Points Table Settings to Interpret Points Properly on page 20.

To Enter Fault Data Manually from the Full Verification Points Table:
1. On the Action menu, click Input Table.

Verify displays the Verification Points dialog. If the error file format you selected earlier is
Generic, Integri, Viking, LM, ECT9090, TTI, TRACE948, PDI, or FASTEK, the Verification
Points dialog that is displayed looks like the following. For other versions, see the sections
following this procedure.

Verification Points Dialog used by Most Error File Formats

2. In the Enter Verification Points group box, select the option to Enter Manually .

3. Enter the verification points into the Verification Points table. You can enter points in
pairs, or you can enter points into the entire table.

4. For each point that you want to display click the On column so that it has a checkmark. If a
point has no checkmark, then the point is not displayed. Generally you will only want to
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turn on two points at a time, and those two points will represent a single fault, a short or an
open.

5. After entering the verification points, set up the other Verification Points Table settings to
interpret the loaded verification points properly. See Setting the Verification Points Table
Settings to Interpret Points Properly on page 20.

Menu: Action-Input Table

Button:

Key: None

EMMA Verification Points Dialog

EMMA Verification Points Dialog

Note: This dialog is the same as the EMMA Quick Input Table and is displayed using the menu
command Action-Input Errors-Manual. The menu command Action-Input Errors-File
displays a dialog in which you can import an EMMA error file.
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UTRON Verification Points Dialog

UTRON Verification Points Dialog

Note: The UTRON Verification Points Dialog does not allow for manual input, so you will have to
use the UTRON Quick Input Table. See Quick Input Table on page 13.

ECT/Custom Kyoei Verification Points Dialog

ECT/Custom Kyoei Verification Points Dialog

Note: The ECT/Custom Kyoei Verification Points Dialog is the same as the ECT/Custom Kyoei
Quick Input Table. See Quick Input Table on page 13.
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Cline/TTI9600 Verification Points Dialog

Cline/TTI9600 Verification Points Dialog

Note: The Cline/TTI9600 Verification Points Dialog does not allow for manual input, so you will
have to use the Cline/TTI9600 Quick Input Table. See Quick Input Table on page 13.
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Setting the Verification Points Table Settings to
Interpret Points Properly

For some tester error file formats, Verify needs some additional information in order to interpret the
loaded verification points properly. Not all error file formats require these additional settings. For
information on setting the tester error file format, see Setting the Tester Error File Format on page 8.

To Set the Verification Points Table Settings to Interpret Loaded Verification Points
Properly:
1. If you are not already in the Verification Table , go to the Action menu, and click Input

Table.

Verify displays the Verification Points dialog. If the error file format you selected earlier is
Generic, Integri, Viking, LM, ECT9090, TTI, TRACE948, PDI, or FASTEK, the Verification
Points dialog that is displayed looks like the following.

Verification Points Dialog used by Most Error File Formats

2. In the Bottom Side group box, select whether the Component Side or Solder Side of the
board was tested as the Bottom Side.

3. In the Netlist Data Source group box, select whether the netlist source is from an Extracted
Netlist File or if it was Self-Learned from a Golden Board.
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4. In the Offset X and Offset Y text boxes, enter the X and Y distance that the fault data is
offset form the Grid Origin , if any.

Note: For some TTI type testers, you can automatically load the offsets by clicking the Load
Offsets button.

5. In the Tester Grid Units drop list, select the Grid Units used by the tester.

6. Click OK

Menu: Action-Input Table

Button:

Key: None
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Saving a Log File of Verification Points
You can save a text log file that contains the verification points currently listed in the Verification
Points Table. In addition to the verification points, the file contains the Pin ID, Reference ID, Signal
ID and whether the error is a short or an open.

To Save a Log File of Verification Points:
1. If you are not already in the Verification Table , go to the Action menu, and click Input

Table.

Verify displays the Verification Points dialog. If the error file format you selected earlier is
Generic, Integri, Viking, LM, ECT9090, TTI, TRACE948, PDI, or FASTEK, the Verification
Points dialog that is displayed looks like the following.

Verification Points Dialog used by Most Error File Formats

2. With the verification points you want to save entered in the Verification Points Table, click
the Save Log button.
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Verify displays the Output Log File dialog.

Output Log File Dialog

3. Click the Browse button to select a directory and enter a file name.

4. In the File group box, select whether to save a New file, which will overwrite any existing file
with the same file name, or to Append to any existing file with the same file name.

5. Click OK .

Verify saves the log file.
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Examining Faults
Verify provides a color-coded graphical representation of the PCB layout, the verification points, the
highlighted nets containing the verification points, and the probable fault areas.

The exact procedures you will use for examining this representation depends on many factors: the
tester error file format; whether the fault data is imported in a file or manually entered into the
Verification Points Table or the Quick Input Table ; and whether you are searching for shorts or
opens. Regardless of the exact procedures you use, you will probably perform the following types of
tasks:

Change the View of the Data on Screen
Depending on your test method, you will probably want to display some types of data and hide other
types. For more on viewing data in Verify, see Viewing Data in Verify on page 33.

Display One Fault at a Time
You will need to turn on and off the sets of verification points that represent faults. In other words, you
will probably want to display one fault at a time and turn off points that represent other faults. In most
cases, this means you or Verify identify a pair of verification points that represent an open or short.
Verify displays the two verification points in the viewing area marked with a white X and highlights
the net(s) that contain the points. How you select which set of points to display depends on how the
data was imported and the error file format.

Enter Faults One at a Time in the Quick Input Table
With some error file formats, the Quick Input Table  only allows two verification points to be entered
at a time. There are no other commands necessary to go to the next set of points. You enter one set of
points into the Quick Input Table  and examine that set of points and their highlighted net(s) on
screen. Then when you are ready for the next set, you enter the next set into the Quick Input Table .
For more information about the Quick Input Table , see Quick Input Table on page 13.

Use the Display Next or Previous Fault Command
With some error file formats, it is possible to load multiple sets of verification points for a single
board. For instance, in some error file formats you can import a file that contains multiple pairs of
points that are in error for a single board. And in some versions of the Quick Input Table , you can
manually enter multiple pairs of points. In those cases where you have a table of pairs of points, you
can use the Display Next or Previous Fault command to automatically skip to the next or previous
fault. When you use the command, the next set of points and their highlighted net(s) are shown on
screen. For more information about the Display Next or Previous Fault command, see Displaying the
Next or Previous Fault in the Verification Table on page 33.
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Use the Display Next or Previous Board Command
With some error file formats, it is possible to import fault data for more than one board. In this case
you can use the Display Next or Previous Board command to automatically skip to the next or
previous board. For more information about the Display Next or Previous Board command, see
Displaying Faults for the Next or Previous Board on page 34. And you can use the Display Next or
Previous Fault command to automatically skip to the next or previous fault for the current board. See
Displaying the Next or Previous Fault in the Verification Table on page 33.

Turn Points On or Off manually in the Verification Points Table
With some error file formats, it is possible to enter into the full Verification Points Table a list of
points that are in error, but are not grouped into pairs. Generally you want to display a pair of
verification points that represent an open or short, so it is up to you to select which individual points to
display at a time. In this case you open the Verification Points Table, and click the On column for the
points that you want turned on so that there is a checkmark. Points that have no checkmark are
turned off. Points that do have a checkmark are shown on screen, and their net(s) are highlighted. For
more information about the Verification Points Table, see Full Verification Points Table on page 16.

Go to Each Verification Point that is Turned On
Once the verification points that represent the fault are turned on, you may want to go to those points
for closer inspection. Each verification point that is turned on is displayed on screen as a white X. Use
the Go to Next Verification Point command to snap the cursor to the active verification points. For
more information on the Go to Next Verification Point command, see Going to the Next Verification
Point for the Selected Fault on page 50.

Once the cursor is at one of the verification points, you can find out information about that point by
selecting it. Selecting the point causes Verify to display information about the point in the Status Bar:
net number, D Code, probe number, board side, etc. For more information about selecting elements,
see Selecting a Test Point or a Pad on page 52, Selecting a Pad on page 52 and  Selecting a Test Point
on page 53. Also once you have identified the pad that contains the verification point, you can find the
position of that pad relative to other pads. This makes it easier to locate the pad on the physical board
so that you can test the point. For information on finding the position of a pad relative to other pads,
see Finding the Position of a Selected Pad Relative to Other Pads on page 51.
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Display the Next or Previous Proximity Check Violation
If the verification points that are turned on belong to different nets, then they represent a short between
those nets, and Verify automatically runs a proximity check on those shorted nets. The proximity
check identifies elements in the two nets that are close to each other. Those elements are potentially
locations on the physical board where the short may have occurred. So the proximity check can help
you find areas to check for shorts on the physical board. If there is a proximity violation between the
two nets, then the nets are shown on screen highlighted in red, and the proximity violations are
displayed on screen as a pair of elements highlighted in yellow. If there are no proximity violations,
the nets are highlighted, but not shown in red. If the proximity check finds more than one proximity
violation you can use the Display Next or Previous Proximity Check Violation command to display
each proximity violation in turn. For more on the Display Next or Previous Proximity Check
Violation  command, see Displaying the Next or Previous Proximity Check Violation on page 34. For
more on setting up the Proximity Check, see Setting up Proximity Parameters on page 7.

If the verification points that are turned on belong to the same net, then they represent an open within
that net, and Verify does not run a proximity check. There is no proximity data to display. The nets are
highlighted, but not shown in red.

Find the Position of a Pad Relative to Other Pads
Once you have used the techniques above to identify a pad of interest, you can find the position of that
pad relative to other pads. This makes it easier to locate the pad on the physical board so that you can
test the point. For information on finding the position of a pad relative to other pads, see Finding the
Position of a Selected Pad Relative to Other Pads on page 51.
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Chapter 3
Verify Interface Overview

Verify has a point-and-click Windows interface with most functions available on command menus and
command toolbars. Many functions can also be activated using shortcut key commands. This chapter
provides a brief overview of the major elements of the interface. For more detailed descriptions of the
commands represented on the individual menus and toolbar buttons, see the topics that describe the
function you want to perform.

Application Window
The Verify Application Window has command menus at the top, toolbars around the edges, a status
bar at the bottom and the viewing area in the center.

Verify Application Window
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Command Menus
Most commands in Verify can be accessed through the command menus. Command menus are usually
accessed by clicking on the command. In this manual, command menu commands are written in bold
and the cascade menus are separated by a dash ( - ).

Command Menu Instruction Example:
� On the View menu, click Zoom-Zoom on Frame.

The instruction in the example means to click the menu shown in the following graphic.

Command Menu Example

Access Keys for Menu Commands
Command menus can also be accessed from the keyboard using what are sometimes called access keys
or accelerator keys. The underlined character in each menu indicates the access key for that menu
selection. To use the access keys press the Alt  key and the first access key indicated in the top-level
menu. The menu drops down. Then press the other access keys indicated in each cascade menu.

Access Key Example:
1. For the example shown in the Command Menu Example graphic, press Alt+V  together.

The View menu drops down.

2. Press Z.

The Zoom cascade menu drops down.

3. Press F.

The Zoom on Frame command is selected.
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Shortcut Keys for Menu Commands
Often a command on the command menus will have an even faster way to access the command by
keyboard. These key commands are sometimes called shortcut keys or hotkeys. If there is an
equivalent key command, it is usually indicated on the final cascade menu. In the example in the
graphic, the shortcut key command is W. There are also shortcut keys for commands that are not on
the menus. For more about shortcut key commands see Key Commands on page 32. For a listing of all
shortcut key commands in Verify, see Key Commands Summary on page 65.

Command Toolbars
Many commands in Verify can be accessed through the command toolbars. Toolbar controls are
activated by clicking on the toolbar button or control. In this manual, toolbar controls are either shown
using a graphic, or the name of the button or control is written in bold.

To Find Out What a Toolbar Control Is:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. The ToolTip gives the name of the control and usually also
gives the equivalent key command. The Message Line in the Status Bar gives some additional
information about the control.

The following sections provide brief descriptions of each of the toolbars. For more detailed
descriptions of the toolbar commands, see the topics that describe the function you want to perform.

Main Toolbar
The Main  toolbar has the Open File command and the About command.

Main Toolbar

To Display the Main Toolbar:
1. On the View menu, go to Toolbar and look at Main .

• If Main  has a checkmark next to it, then the Main  toolbar is being displayed.

• If Main  has no checkmark next to it, then the Main  toolbar is not being displayed.

2. Click Main  to switch between displaying or not displaying the Main  toolbar.

Menu: View-Toolbar-Main

Button: None

Key: None
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Side Toolbar
The Side toolbar has the main commands for performing fault verification.

Side Toolbar

To Display the Side Toolbar:
1. On the View menu, go to Toolbar and look at Side.

• If Side has a checkmark next to it, then the Side toolbar is being displayed.

• If Side has no checkmark next to it, then the Side toolbar is not being displayed.

2. Click Side to switch between displaying or not displaying the Side toolbar.

Menu: View-Toolbar-Side

Button: None

Key: None

Screen Toolbar
The Screen toolbar has controls for changing the view of the Viewing Area and changing how the
cursor coordinates and distance are shown.

Screen Toolbar
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Status Bar
The Status Bar provides information about the selected elements and displays messages from the
system, such as prompts for commands.

Status Bar

To Display the Status Bar:
1. On the View menu, go to Status Bar.

• If Status Bar has a checkmark next to it, then the Status Bar is being displayed.

• If Status Bar has no checkmark next to it, then the Status Bar is not being displayed.

2. Click Status Bar to switch between displaying or not displaying the Status Bar.

Menu: View-Status Bar

Button: None

Key: None
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Key Commands
Many commands in Verify can be accessed through the keyboard using the key commands.

Shortcut Key Commands
Shortcut keys are the fastest way to activate commands. Shortcut keys are usually a single keyboard
key (such as R or D), or they can use the Shift or Ctrl  keys modifiers (such as Shift+R or Ctrl+R ).
For a complete list of all shortcut keys in Verify, see Key Commands Summary on page 65.

To Find the Shortcut Key for a Menu Command:
� Go to the menu command that you want to use.

If there is a shortcut key for that command, it will be indicated on the final cascade menu.

To Find the Shortcut Key for a Toolbar Control:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. If there is a shortcut key for that command, it will be
indicated on the ToolTip.

Access Key Commands
Access keys are just an alternative way to activate a menu command. The underlined character in each
menu indicates the access key for that menu selection. To use the access keys press the Alt  key and the
first access key indicated in the top-level menu, and then press the other access key indicated in each
cascade menu. For more about access keys, see Command Menus on page 28.
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Chapter 4
Viewing Data in Verify

Verify has many options for viewing data. You can choose what data to display on screen, highlight
certain types of data, zoom up and down, go to specific locations or types of data, use an on-screen
reference frame, use an on-screen positioning grid, measure distance, display job statistics, and switch
between English and metric units.

Choosing What Data to Display
Verify has many commands that allow you to control what data is displayed on screen.

Displaying the Next or Previous Fault in the Verification Table
If there is more than one set of verification points in the Verification Points Table, then you can use
the Next Fault or Previous Fault commands to display the next or previous set of verification points.

To Display the Next or Previous Fault in the Verification Table:
� Press Shift+N to see the next fault in the verification table, or press N to see the previous.

Menu: None

Button:

Key: Shift+N = Next fault
N = Previous fault
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Displaying the Next or Previous Proximity Check Violation
If the currently displayed set of verification points represents a short, then Verify automatically runs a
proximity check on the shorted nets using the proximity parameters you set up. For information on
setting up the proximity parameters, see Setting up Proximity Parameters on page 7. The proximity
check identifies elements in the two nets that are close to each other, and these proximity violations are
locations where the short might have occurred. If there is a proximity violation between the two nets,
then the nets are shown on screen highlighted in red. And the proximity violations are displayed on
screen as a pair of elements highlighted in yellow. If there is more than one proximity violation for the
set of verification points, then you can use the Next Proximity Violation  or Previous Proximity
Violation  commands to display the next or previous proximity violation.

To Display the Next or Previous Proximity Check Violation:
� Press Shift+V  to see the next proximity check violation for the selected fault, or press V to

see the previous.

Menu: None

Button:

Key: Shift+V = Next proximity check violation
V = Previous proximity check violation

Displaying Faults for the Next or Previous Board
If you have imported an error file that includes faults for more than one board, then you can use the
Next Board or Previous Board commands to skip to the first fault of the next or previous board.

Note: Not all error file formats support fault data for more than one board, and the Quick Input
Verification Points Table does not support fault data for more than one board. This feature
only works if the imported error file includes data for more than one board.

To Display Faults for the Next or Previous Board:
� Press Shift+J to see faults for the next board, or press J to see faults for the previous.

Menu: None

Button:

Key: Shift+J = Next board
J = Previous board
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Displaying Verification Points with a Large White X
You can choose to display or not to display the verification points with a large white X. The large
white X makes the verification points easier to see.

To Display the Verification Points with a Large White X:
1. On the Show menu, go to Large Ver Points.

• If Large Ver Points has a checkmark next to it, then the verification points are being
displayed with a large white X.

• If Large Ver Points has no checkmark next to it, then the verification points are not
being displayed with a large white X.

2. Click Large Ver Points to switch between displaying or not displaying the verification points
with a large white X.

Menu: Show- Large Ver Points

Button: None

Key: None
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Large Verification Points Turned Off

Large Verification Points Turned On
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Displaying the PCB Data
You can choose to display or not to display the imported PCB data.

Note: If it ever appears that your PCB data has just disappeared, it may be that you have
accidentally activated this command. Just press B again to restore it.

To Display the PCB Data:
� Press B.

Menu: None

Button: None

Key: B

Displaying Component Side, Solder Side or Inner Layer Data
The PCB data may contain component side data, solder side data and inner layer data, and you can
control which layers are displayed at any time.

To Display Component Side, Solder Side or Inner Layer Data:
1. On the Show menu, go to CPU, CPL or Inner.

• If the layer you are interested in (CPU, CPL or Inner) has a checkmark next to it, then
that layer is being displayed.

• If you are interested in (CPU, CPL or Inner) has no checkmark next to it, then that
layer is not being displayed.

2. Click CPU, CPL or Inner to switch between displaying or not displaying that layer.

Menu: Show-CPU
Show-CPL
Show-Inner

Button: None

Key: Shift+L   This key command controls the display of all of the layers. By pressing the key
command repeatedly you can cycle through displaying various layer combinations. Each
layer combination is indicated in the Status Bar by a one-letter code: all the layers
together (A), both CPU and CPL (B), CPU only (C), CPL only (S), and Inner only (I).
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Setting the Active Layer
Verify allows you to control which board side (component or solder) is active. Only elements in the
active layer can be selected. The currently active side is shown in the Status Bar, either CMP or SOL.
In addition to controlling which PCB side is active, this command also controls which side of the
fixture data, if any, is visible.

To Display Component Side or Solder Side Data:
� On the Show menu, click Active Layer.

Menu: Show-Active Layer

Button:

Key: Shift+O
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Flipping the Component Side or Solder Side Data
You can choose to display the component side and/or the solder side data in a mirrored orientation.

To Flip the Component Side or Solder Side Data:
1. On the Show menu, click Flip CMP  or Flip SOL.

Verify displays the Flip Layer CMP  or Flip Layer SOL  dialog.

Flip Layer CMP Dialog

2. On the Flip Layer CMP  or Flip Layer SOL  dialog, select the orientation in which you want
to display the layer.

• None: The layer is not flipped and is shown exactly as imported. This option can be
selected to restore data that has been flipped to its original orientation.

• Flip X (Horizontal):  The layer is flipped in the X-axis so that left becomes right.

• Flip Y (Vertical):  The layer is flipped in the Y-axis so that top becomes bottom.

3. Click OK .

Verify displays the data flipped in the orientation you selected.

Menu: Show-Flip CMP
Show-Flip SOL

Button: None

Key: Shift+X = Flip CMP
Ctrl+X = Flip SOL
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Component Side as Imported, before Flip

Component Side After Flip Y
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Displaying All Pads or Only Pads with Test Points
When the PCB data is being displayed you can choose to display all pads or only pads that have test
points on them.

To Display All Pads or Only Pads with Test Points:
� Press Shift+P.

Menu: None

Button: None

Key: Shift+P

Displaying Silkscreen Data
If the FixMaster/ProbeMaster .JOB file contains a silkscreen data file, you can choose to display or not
to display the silkscreen data.

To Display Silkscreen Data:
1. On the Show menu, go to Silkscreen.

• If Silkscreen has a checkmark next to it, then silkscreen data is being displayed.

• If Silkscreen has no checkmark next to it, then silkscreen data is not being displayed.

2. Click Silkscreen to switch between displaying or not displaying silkscreen data.

Menu: Show-Silkscreen

Button: None

Key: K

Displaying Soldermask Data
If the FixMaster/ProbeMaster .JOB file contains a soldermask data file, you can choose to display or
not to display the soldermask data.

To Display Soldermask Data:
1. On the Show menu, go to Soldermask.

• If Soldermask has a checkmark next to it, then soldermask data is being displayed.

• If Soldermask has no checkmark next to it, then soldermask data is not being
displayed.

2. Click Soldermask to switch between displaying or not displaying soldermask data.

Menu: Show-Soldermask

Button: None

Key: None
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Displaying Board Outline Data
If the FixMaster/ProbeMaster .JOB file contains a board outline data file, you can choose to display or
not to display the board outline data.

To Display Board Outline Data:
1. On the Show menu, go to Board Outline.

• If Board Outline has a checkmark next to it, then board outline data is being displayed.

• If Board Outline has no checkmark next to it, then board outline data is not being
displayed.

2. Click Board Outline to switch between displaying or not displaying board outline data.

Menu: Show-Board Outline

Button: None

Key: O

Displaying the Fixture Grid Points
You can choose to display or not to display the fixture grid points. The fixture grid points appear on
screen as small red crosses.

Note: This command has no meaning for ProbeMaster .JOB files because they do not contain
fixture grid points.

To Display the Fixture Grid Points:
1. On the Show menu, go to Grid .

• If Grid has a checkmark next to it, then the fixture grid points are being displayed.

• If Grid has no checkmark next to it, then the fixture grid points are not being
displayed.

2. Click Grid to switch between displaying or not displaying the fixture grid points.

Menu: Show-Grid

Button: None

Key: None
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Displaying the Fixture Pins
You can choose to display or not to display the fixture pins that connect the test points to their assigned
fixture grid points. The fixture pins appear on screen as blue lines between the test points and the gird
points.

Note: This command has no meaning for ProbeMaster .JOB files because they do not contain
fixture pins.

To Display Fixture Pins:
1. On the Show menu, go to Probes.

• If Probes has a checkmark next to it, then the fixture pins are being displayed.

• If Probes has no checkmark next to it, then the fixture pins are not being displayed.

2. Click Probes to switch between displaying or not displaying the fixture pins.

Menu: Show-Probes

Button: None

Key: None

Displaying the Fixture Drills
You can choose to display or not to display the fixture drills. This option allows you to display the
outside tooling, spacers and other drills that you add manually in FixMaster, not the probe drills that
FixMaster creates.

Note: This command has no meaning for ProbeMaster .JOB files because they do not contain
fixture drills.

To Display the Fixture Drills:
1. On the Show menu, go to Fixture .

• If Fixture  has a checkmark next to it, then the fixture drills are being displayed.

• If Fixture  has no checkmark next to it, then the fixture drills are not being displayed.

2. Click Fixture  to switch between displaying or not displaying the fixture drills.

Menu: Show-Fixture

Button: None

Key: L
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Displaying the Wire Wrap Road Map
For wire wrapped jobs from FixMaster you can choose to display or not to display the wire wrap road
map.

Note: This command has no meaning for ProbeMaster .JOB files because they do not contain wire
wrap information.

To Display the Wire Wrap Road Map:
1. On the Show menu, go to Road Map.

• If Road Map has a checkmark next to it, then the wire wrap road map is being
displayed.

• If Road Map has no checkmark next to it, then the wire wrap road map is not being
displayed.

2. Click Road Map to switch between displaying or not displaying the wire wrap road map.

Menu: Show-Road Map

Button: None

Key: None
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Displaying Fiducials
Verify has a command for displaying fiducials tagged in ProbeMaster.

Note: This command has no meaning for FixMaster .JOB files because they do not contain
fiducials.

To Display Fiducials:
1. On the Show menu, click Fiducials.

Verify displays the same Fiducials table that is displayed in ProbeMaster when the fiducials are
set.

Fiducials Dialog

2. If the fiducial locations are correct, click OK . If they are not correct, enter the new locations
and click OK .

Each fiducial is displayed as a large magenta X.

Menu: Show-Fiducials

Button: None

Key: None
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Displaying Net Numbers
Verify can display the net numbers of pads on screen. Net numbers are shown only for the nets in error
that are currently highlighted. The net numbers appear next to the test points.

To Display Net Numbers:
1. On the Show menu, go to Netcode.

• If Netcode has a checkmark next to it, then the net numbers are being displayed.

• If Netcode has no checkmark next to it, then the net numbers are not being displayed.

2. Click Netcode to switch between displaying or not displaying the net numbers.

Menu: Show-Netcode

Button: None

Key: F

Displaying Test Point Numbers
Each test point is assigned a unique test point number when the test files are exported from
ProbeMaster. Most moving probe testers report faults between test point numbers (i.e., a short between
test points 14 and 25). Verify can display the test point number next to each test point.

Note: This command has no meaning for FixMaster .JOB files because they do not contain test
point numbers.

To Display Test Point Numbers:
1. On the Show menu, go to Test Point Numbers.

• If Test Point Numbers has a checkmark next to it, then the test point numbers are being
displayed.

• If Test Point Numbers has no checkmark next to it, then the test point numbers are not
being displayed.

2. Click Test Point Numbers to switch between displaying or not displaying the test point
numbers.

Menu: Show-Test Point Numbers

Button: None

Key: None



Chapter 4 Viewing Data in Verify

47

Highlighting a Specific Net
You can highlight a specific net.

To Highlight a Specific Net:
1. On the Show menu, click Netlist.

Verify prompts for a net number.

Highlight Net

2. On the Net dialog, enter the number of the net you want to highlight and click OK .

Verify highlights the net and displays the net’s traces if any.

Highlighted Net

Menu: Show-Netlist

Button: None

Key: Shift+F
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Going to Specific Locations on Screen
Verify has many commands for going to specific location or specific types of data on screen.

Moving the Cursor Manually
You can manually move the cursor around on the viewing area using the mouse or the arrow keys.

Using the Mouse
Moving the mouse moves the cursor around the screen. You can use the mouse to move the cursor
outside the viewing area to click on menus and buttons, which is something you cannot do using the
arrow keys. When the screen grid is turned on, moving the cursor with the mouse allows you to
position the cursor off of the grid points, which is also something you cannot do using the arrow keys.

Using the Arrow Keys
Pressing the arrow keys moves the cursor up, down, left or right on the viewing area. When the screen
grid is turned on, pressing the arrow keys causes the cursor to hop from one grid point to the next. The
arrow keys cannot be used to move the cursor outside the viewing area to click on menus and buttons.
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Going to Specific X, Y Coordinates
You can go to a specific X, Y coordinate.

To Go to Specific X, Y Coordinates:
1. On the View menu, click Go To-Coordinates.

Verify prompts for X and Y coordinates.

Move Cursor To dialog

2. On the Move Cursor To dialog, enter new X and Y coordinates and press the Enter key.

Verify moves the cursor to the X and Y coordinates.

Note: It is usually preferable to close the dialog using the Enter key instead of clicking OK.
Clicking OK can sometimes cause you to jiggle the mouse and move the cursor off of the
coordinates you set.

Menu: View-Go To-Coordinates

Button:  Click the X or Y buttons.

Key: X key or Y key
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Going to the Next Verification Point for the Selected Fault
A fault is generally defined by two verification points in the verification table which represent two
points that are shorted or open. In addition you may select to display more than two verification points
at a time by turning them on in the full Verification Points Table. You can use the Go to Next
Verification Point  command to go to each verification point that is being displayed.

To Go to the Next Verification Point for the Selected Fault:
� Press P.

The cursor snaps to the next verification point for the selected fault.

Menu: None

Button: None

Key: P
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Finding the Position of a Selected Pad Relative to Other Pads
Verify can provide the location of a selected pad relative to other pads within the reference frame. For
instance, in a block of ten pads, the location of a selected pad might be reported by Verify as,
“Position: Left 3   Right 8.” This would mean that the selected pad is the third from the left or the
eighth from the right in the block. This feature makes it easier to find the pad on the physical board.

To Find the Position of a Selected Pad:
1. Position the reference frame around the block of pads containing the pad you want to locate.

2. Click the Locates Pad button .

3. Click on the pad you want to locate.

The cursor hops to the center of the pad and marks it with a green crosshair.

4. Click again.

In the Message Line of the Status Bar, Verify reports the position of the pad relative to the edges
of the block of pads. For horizontal blocks the position is reported counting from the left and right
edges. And for vertical blocks the position is reported counting from top and bottom edges.

The pad location is reported in the Status Bar, “Position: Left 3   Right 8”

Menu: None

Button:

Key: None
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Selecting a Test Point or a Pad
Verify has a generic selection command for selecting a test point or a pad, whichever is closest.
Selecting an element causes the cursor to hop to the selected element. It also causes the properties of
the selected element (i.e., net number, D Code, probe number, and board side) to be displayed in the
Status Bar. Only elements in active data can be selected.

To Select a Test Point or Pad:
1. Make the board side that contains the test point or pad active and visible. See Displaying

Component Side, Solder Side or Inner Layer Data on page 37, and see Setting the Active
Layer on page 38.

2. Position the cursor on the test point or pad.

3. Press S.

The cursor hops to the selected test point or pad, and the element’s properties are displayed in the
Status Bar.

Note: If a different test point or pad than the one you expected is selected, or if it looks like an
element that you cannot see has been selected, check to be sure that the correct board
side is visible and that it is active.

Menu: None

Button: None

Key: S

Selecting a Pad
Selecting a pad causes the cursor to hop to the selected pad. It also causes the pad’s properties (i.e., net
number, D Code, probe number, and board side) to be displayed in the Status Bar. Only pads in active
data can be selected.

To Select a Pad:
1. Make the board side that contains the pad active and visible. See Displaying Component Side,

Solder Side or Inner Layer Data on page 37, and see Setting the Active Layer on page 38.

2. Position the cursor on the pad.

3. Press Q.

The cursor hops to the selected pad, and the pad’s properties are displayed in the Status Bar.

Note: If a different pad than the one you expected is selected, or if it looks like an element that
you cannot see has been selected, check to be sure that the correct board side is visible
and that it is active.

Menu: None

Button: None

Key: Q
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Selecting a Test Point
Selecting a test point causes the cursor to hop to the selected test point. It also causes the properties of
the selected test point’s pad (i.e., net number, D Code, probe number, and board side) to be displayed
in the Status Bar. Only test points in active data can be selected.

To Select a Test Point:
1. Make the board side that contains the test point active and visible. See Displaying Component

Side, Solder Side or Inner Layer Data on page 37, and see Setting the Active Layer on page
38.

2. Position the cursor on the test point.

3. Press Shift+Q.

The cursor hops to the selected test point, and the test point’s properties are displayed in the
Status Bar.

Note: If a different test point than the one you expected is selected, or if it looks like an element
that you cannot see has been selected, check to be sure that the correct board side is
visible and that it is active.

Menu: None

Button: None

Key: Shift+Q

Going to the Last Selected Test Point
Pressing Ctrl+H  moves the cursor to the last selected test point. If the selected test point is off the
screen, Verify redraws the screen at the current zoom level with the selected test point in the center. A
green cross marks the selected test point.

To Go to the Last Selected Test Point:
� Press Ctrl+H .

Menu: None

Button: None

Key: Ctrl+H
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Going to a Test Point
The Go to Test Point command causes the cursor to hop to the closest test point. Unlike the Select
Test Point command, the Go to Test Point command does not cause the properties of the selected test
point to be displayed in the Status Bar. The command only works for test points in active data.

To Go to a Test Point:
1. Make the board side that contains the test point active and visible. See Displaying Component

Side, Solder Side or Inner Layer Data on page 37, and see Setting the Active Layer on page
38.

2. Position the cursor on the test point.

3. Press A.

The cursor hops to the test point.

Note: If the cursor hops to a different test point than the one you expected, or if it looks like the
cursor hopped to an element that you cannot see, check to be sure that the correct board
side is visible and that it is active.

Menu: None

Button: None

Key: A

Going to a Trace
The Go to Trace command causes the cursor to hop to the closest trace. The command only works for
traces that are displayed when a net that has a fault is being displayed. Unlike the selection commands,
the Go to Trace command does not cause the properties of the selected trace to be displayed in the
Status Bar.

To Go to a Trace:
1. Select some verification points to display so that the net(s) with the fault(s) are highlighted.

2. Position the cursor on the trace.

3. Press Shift+A .

The cursor hops to the trace.

Menu: None

Button: None

Key: Shift+A
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Going to the Datum Point
To Go To the Datum Point:
� On the Show menu, click Datum Point.

The cursor goes to the datum point.

Menu: Show-Datum Point

Button: None

Key: None

Moving between a Test Point and Its Grid Point
The Move between a Test Point and Its Grid Point command causes the cursor to hop from a
selected test point to its assigned fixture grid point. This only works if the loaded .JOB file is a
FixMaster job.

To Move between a Test Point and Its Grid Point:
1. Select the test point.

2. Press E.

The cursor hops to the grid point.

3. Press E again.

The cursor hops back to the test point.

Menu: None

Button: None

Key: E
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Zooming on Data
Verify has several commands for zooming up and down on the viewing area and zooming on specific
areas of the screen.

Zooming Up or Down in Steps
You can zoom up or down by a fixed amount.

To Zoom Up or Down:
� On the View menu, click Zoom-Zoom Up or Zoom Down.

Verify zooms the viewing area up or down, centered on the cursor position.

Note: It is usually preferable to run this command from the keyboard rather than the command
menus because you have more control over the cursor position when the command is
activated. This allows you to control the exact position to zoom on.

Menu: View-Zoom-Zoom Up or Zoom Down

Button:   Click the button, then click in the viewing area to Zoom Up.
No button for Zoom Down.

Key: Page Up key or Page Down key

Zooming to Show All Data
You can zoom so that all data fits in the screen.

To Zoom so that All Data is Shown on Screen:
� On the View menu, click Zoom-Zoom Show All.

Verify zooms up or down so that all data on screen fits inside the viewing area.

Menu: View-Zoom-Zoom to Show All

Button:

Key: Home key

Zooming on the Reference Frame
You can zoom on the Reference Frame.

To Zoom on the Reference Frame:
� On the View menu, click Zoom-Zoom On Frame.

Verify zooms on the Reference Frame.

Menu: View-Zoom-Zoom on Frame

Button: None

Key: W
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Zooming to a Specific Zoom Level
You can set an exact zoom level.

To Zoom to a Specific Zoom Level:
1. On the View menu, click Zoom-Set Zoom Level.

Verify prompts for a zoom level.

Set Zoom Level

2. On the Set Zoom Level dialog, enter the zoom level and click OK .

Verify zooms to the zoom level you selected.

Menu: View-Zoom-Set Zoom Level

Button:    Type the zoom level into the control and then move the mouse into the
viewing area.

Key: Z
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Using the Reference Frame
Verify features a Reference Frame, which is used by many commands to select elements for an
operation. You can draw a new Frame at a new location or a new size using a mouse-operated Frame-
drawing tool. And you can also zoom on the Reference Frame. See Zooming on the Reference Frame
on page 56.

Drawing a New Reference Frame
You can draw a new Frame at a new location or a new size using a mouse-operated Frame-drawing
tool.

To Draw a New Reference Frame:

1. On the Screen toolbar, click the New Window  button.

The New Window button stays down and the Frame-drawing tool is selected.

2. Position the cursor where you want one corner of the Frame to be to be. Then click the mouse
and drag the cursor to where you want the opposite corner.

The Frame-drawing tool remains selected until you select another tool or press the Escape key.

Menu: None

Button:  

Key: Shift+W
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Using the Screen Grid
The program has a screen grid that can be used for precisely positioning the cursor. The grid can be
turned on and off as needed.

When the grid is on:

• The cursor moves only on the grid points when moved with the arrow keys.

• The cursor can be moved off the grid using the mouse or by aligning to an element.

Some settings affect the behavior of the grid:

• The space between grid points can be fixed at one interval or can be set to be variable
depending on the zoom level.

• The grid can be anchored so that it does not move, or it can be dragged by the cursor.

Turning the Screen Grid On or Off
You can turn the display of the screen grid on and off.

To Turn the Screen Grid On or Off:
� Press G.

Menu: None

Button: None

Key: G

Anchored or Dragged Grid
The grid can be Anchored in place so that it does not move. When the grid is set to Anchored mode
and the cursor is moved, the cursor hops from one grid point to the next.

Or the grid can be Dragged so that it is moveable. When the grid is set to Dragged mode and the
cursor is moved, the cursor drags the grid to a new position.

Generally the grid is left in Anchored mode and is only put in Dragged mode when it needs to be
repositioned.

To Switch between an Anchored Grid and One that can be Dragged:
� Press Shift+G.

Menu: None

Button: None

Key: Shift+G
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Fixed or Variable Grid
The grid can be set to Variable or Fixed mode. The difference between these two modes is the interval
displayed between grid dots.

• Variable Mode: The program changes the displayed grid interval so that a comfortable
number of grid dots appears on screen at any zoom level. The displayed grid interval will be
equal to a multiple of the grid unit. The possible grid intervals are grid unit times a power of
ten or any such value divided by two.

As you increase the zoom level, the grid interval becomes smaller to the point of the finest
resolution until it reaches the grid unit. It will never be smaller than the grid unit.

• Fixed Grid:  The interval displayed between grid dots is always equal to the grid unit, at any
zoom level. The grid interval does not change until the screen is almost filled with grid dots.
When there are too many dots to display, the grid becomes invisible, but it is still on.

To Switch between a Fixed Interval Grid and One that is Variable with Zoom:
� Press Ctrl+G .

Menu: None

Button: None

Key: Ctrl+G
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Measuring Distance
Verify allows you to measure distance in the viewing area in two different ways. You can measure the
straight-line distance between two points in Distance Measurement mode. Or you can use a Relative
Origin , which gives you the X and Y distances from one point to the other.

Using Distance Measurement Mode
When Distance Measurement mode is on, the Screen toolbar shows distance between the current
cursor position and the starting point where the cursor was when Distance Measurement mode was
turned on.

To Measure Distance with Distance Measure Mode:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the D key.

Verify marks the starting point on screen with a yellow X and goes into Distance Measure mode.
The Screen toolbar begins displaying the distance between the starting point on screen and the
cursor position.

Distance Displayed in the Screen Toolbar

3. Move the cursor to the point on screen where you want to measure distance to.

The Screen toolbar displays the distance between the starting point on screen and the cursor
position. Verify remains in Distance Measurement mode until you press D again.

Menu: None

Button: None

Key: D
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Using the Relative Origin
Ordinarily the Screen toolbar shows the cursor’s X and Y coordinate position relative to the absolute
origin, X=0, Y=0. When the Relative Origin is turned on, the Screen toolbar shows cursor’s dx and
dy position relative to the Relative Origin, dx=0, dy=0. The Relative Origin, dx=0, dy=0, is the point
on screen where the cursor was when the Relative Origin was turned on.

To Measure Distance with the Relative Origin:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the R key.

Verify switches to Relative Origin mode. Instead of the normal X, Y coordinates, the Screen
toolbar begins displaying the cursor position as the dx and dy coordinates relative to the position
on screen where Relative Origin mode was turned on.

Absolute Origin Mode

Relative Origin Mode

3. Move the cursor to the point on screen where you want to measure distance to.

The Screen toolbar displays the dx and dy distance between the Relative Origin and the cursor
position. Verify remains in Relative Origin mode until you press R again.

Menu: None

Button: None

Key: R
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Showing the Job Statistics
Verify can display a dialog that shows statistics for the currently loaded .JOB file.

To Show the Job Statistics:
� On the Show menu, click Dimensions.

Test Information Statistics Dialog

Menu: Show-Dimensions

Button: None

Key: F6

Metric or English Units
Verify can convert units of measurement for the current job between English and metric units.

To Select Metric or English Units:

1. On the Screen toolbar, click the Coordinate Units drop down  and select either
Inches or mm.

Verify prompts, “Convert all data and parameters to metric/English?”

2. Click Yes.

Verify converts the database to the new units.

Menu: None

Button:

Key: None
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Chapter 5
Key Commands Summary

In Verify, many menu and toolbar commands have shortcut key equivalents, and some commands are
only activated by key commands. Shortcut key commands are usually the fastest way to activate
commands. In addition all menu commands can be accessed using access key commands, which are an
alternative way of working the command menus. See Command Menus on page 28.

This section lists the shortcut key commands.

File Commands
Open a FixMaster/ProbeMaster Job File Ctrl+O

Displaying Data
Display Component Side, Solder Side and
Inner Data Shift+L

Switch Active Layer Shift+O

Display the PCB Data B

Flip Display of Component Side or
Solder Side Data Shift+X or Ctrl+X

Display All Pads or Only Pads with Test Points Shift+P

Display Net Numbers F

Display Silkscreen Data K

Display Board Outline Data O

Display the Fixture Drills L

Show Job Statistics F6

Display the Next/Previous Fault in the
Verification Table Shift+N or N

Display the Next or Previous
Proximity Check Violation Shift+V or V

Display Faults for the Next or Previous Board Shift+J or J

Highlighting Data
Highlight a Specific Netlist Shift+F
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Zooming
Zoom Up or Down Page Up or Page Down

Zoom so that All Data is Shown on Screen Home

Zoom on the Reference Frame W

Zoom to a Specific Zoom Level Z

Going to Locations on Screen
Move the Cursor Arrow Keys

Go To Specific X, Y Coordinates X or Y

Select a Pad or Test Point S

Select a Pad Q

Select a Test Point Shift+Q

Go to a Test Point A

Go to a Trace Shift+A

Go to the Last Selected Test Point Ctrl+H

Move between a Test Point and Its Grid Point E

Go to the Next Verification Point P

Screen Grid
Turn the Screen Grid On or Off G

Anchored or Dragged Grid Shift+G

Fixed or Variable Grid Ctrl+G

Measuring Distance
Measure Distance with Distance Measure Mode D

Measure Distance with the Relative Origin R

Reference Frame
Draw a New Reference Frame Shift+W

Enter Fault Data
Quick Input Table Forward Slash ( / )
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Index

A
Access Keys

Key Commands Overview, 32
Active Layer, 38
All Data

Zooming to Show All Data, 56
Anchored or Dragged Grid, 59
Application Window, 27

B
Board

Displaying Faults for the Next or Previous Board, 34
Board Outline

Displaying Board Outline Data, 42
Board Side

Active Layer, 38
Displaying Component Side

Solder Side or Inner Layer Data, 37
Flipping the Component Side or Solder Side Data, 39

C
Commands

Command Menus, 28, 29
Command Toolbars, 29
Key Commands Overview, 32
Key Commands Summary List, 65

Comments
Send Us Your Comments, 2

Component Side
Active Layer, 38
Displaying Component Side

Solder Side or Inner Layer Data, 37
Flipping the Component Side or Solder Side Data, 39

Contact Information
Send Us Your Comments, 2

Coordinates
Going to Specific X Y Coordinates, 49
Using the Relative Origin, 62

Curosr
Moving the Cursor Manually, 48

Current Board Side
Active Layer, 38
Displaying Component Side

Solder Side or Inner Layer Data, 37

D
Datum Point

Going To the Datum Point, 55
Dimensions

Showing the Job Statistics, 63
Display

Choosing What Data to Display, 33
Displaying All Pads or Only Pads with Test Points, 41
Displaying Board Outline Data, 42
Displaying Component Side

Solder Side or Inner Layer Data, 37
Displaying Faults for the Next or Previous Board, 34
Displaying Fixture Grid Points, 42
Displaying Net Numbers, 46
Displaying Silkscreen Data, 41
Displaying Soldermask Data, 41
Displaying Test Point Numbers, 46
Displaying the Fiducials, 45
Displaying the Fixture Drills, 43
Displaying the Fixture Pins, 43
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying the Next or Previous Proximity Check

Violation, 34
Displaying the PCB Data, 37
Displaying the Wire Wrap Road Map, 44
Displaying Verification Points with a Large X, 35
Highlighting a Specific Net, 47
Showing the Job Statistics, 63
Viewing Data in Verify Overview, 33

Distance Measurement
Distance Measurement Overview, 61
Using Distance Measurement Mode, 61
Using the Relative Origin, 62

Download Updates, 3
Dragged or Anchored Grid, 59
Drills

Displaying the Fixture Drills, 43

E
English or Metric Units, 63
Error File

Import a Fault File from the Tester, 9
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Setting the Tester Error File Format, 8
Errors

Displaying Faults for the Next or Previous Board, 34
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying the Next or Previous Proximity Check

Violation, 34
Displaying Verification Points with a Large X, 35
Enter Coordinates of Shorts and Open Points

Manually, 13
Entering Fault Data Overview, 9
Examining Faults Technique, 24
Fault Verification Procedure Overview, 5
Finding the Position of a Selected Pad, 51
Going to the Next Verification Point for the Selected

Error, 50
Saving a Log File of Verification Points, 22
Verification Points Table Settings to Properly

Interpret Loadded Verification Points, 20

F
Fault File, 8, 9

Import a Fault File from the Tester, 9
Setting the Tester Error File Format, 8

Faults
Displaying Faults for the Next or Previous Board, 34
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying the Next or Previous Proximity Check

Violation, 34
Displaying Verification Points with a Large X, 35
Enter Coordinates of Shorts and Open Points

Manually, 13
Entering Fault Data Overview, 9
Examining Faults Technique, 24
Fault Verification Procedure Overview, 5
Finding the Position of a Selected Pad, 51
Going to the Next Verification Point for the Selected

Error, 50
Saving a Log File of Verification Points, 22
Verification Points Table Settings to Properly

Interpret Loadded Verification Points, 20
Feedback

Send Us Your Comments, 2
Fiducials

Displaying the Fiducials, 45
Fixed or Variable Grid, 60
FixMaster Job File

Opening the FixMaster/ProbeMaster Job File, 6
Fixture

Displaying Fixture Grid Points, 42
Displaying the Fixture Drills, 43
Displaying the Fixture Pins, 43
Moving between a Test Point and Its Grid Point, 55

Flip
Flipping the Component Side or Solder Side Data, 39

Format, 8
Setting the Tester Error File Format, 8

Frame
Drawing a New Reference Frame, 58
Using the Reference Frame Overview, 58
Zooming on the Reference Frame, 56

G
Go To

Going to a Test Point, 54
Going to a Trace, 54
Going to Specific Locations on Screen Overview, 48
Going to Specific X Y Coordinates, 49
Going To the Datum Point, 55
Going to the Last Selected Test Point, 53
Going to the Next Verification Point for the Selected

Error, 50
Moving between a Test Point and Its Grid Point, 55
Moving the Cursor Manually, 48

Grid
Anchored or Dragged Grid, 59
Displaying Fixture Grid Points, 42
Fixed or Variable Grid, 60
Turning the Screen Grid On or Off, 59
Using the Screen Grid, 59

Grid Point
Moving between a Test Point and Its Grid Point, 55

H
Highlight

Highlighting a Specific Net, 47
Hotkeys

Key Commands Overview, 32
Key Commands Summary List, 65

I
Import a Fault File from the Tester, 9
Inches or Milllimeters, 63
Inner Layer

Displaying Component Side
Solder Side or Inner Layer Data, 37
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Interface
Application Window, 27
Command Menus, 28
Command Toolbars, 29
Key Commands Overview, 32
Main Toolbar, 29
Screen Toolbar, 30
Side Toolbar, 30
Status Bar, 31
Verify Interface Overview, 27

J
Job File

Opening the FixMaster/ProbeMaster Job File, 6
Job Statistics

Showing the Job Statistics, 63

K
Key Commands

Key Commands Overview, 32
Key Commands Summary List, 65

L
Lavenir

Lavenir Technical Support, 2
Send Us Your Comments, 2

Locate
Finding the Position of a Selected Pad, 51

Log File, 22, 23
Saving a Log File of Verification Points, 22

M
Main Toolbar, 29
Measure Distance

Distance Measurement Overview, 61
Using Distance Measurement Mode, 61
Using the Relative Origin, 62

Menus
Command Menus, 28

Metric or English Units, 63
Milllimeters or Inches, 63
Mirror

Flipping the Component Side or Solder Side Data, 39
Mouse

Moving the Cursor Manually, 48
Move

Moving the Cursor Manually, 48

N
Netlist

Displaying Net Numbers, 46
Displaying the PCB Data, 37
Highlighting a Specific Net, 47

No Data
PCB Data Looks Like It Disappeared, 37

Numbers
Displaying Net Numbers, 46
Displaying Test Point Numbers, 46

O
Opening the FixMaster/ProbeMaster Job File, 6
Opens

Enter Coordinates of Shorts and Open Points
Manually, 13

Entering Fault Data Overview, 9
Examining Faults Technique, 24
Fault Verification Procedure Overview, 5
Finding the Position of a Selected Pad, 51
Going to the Next Verification Point for the Selected

Error, 50
Verification Points Table Settings to Properly

Interpret Loadded Verification Points, 20
Origin

Using the Relative Origin, 62
Outside Tooling

Displaying the Fixture Drills, 43

P
Pad

Finding the Position of a Selected Pad, 51
Selecting a Pad, 52
Selecting a Test Point or a Pad, 52

PCB Data
Displaying the PCB Data, 37

Pins
Displaying the Fixture Pins, 43

ProbeMaster Job File
Opening the FixMaster/ProbeMaster Job File, 6

Probes
Displaying the Fixture Pins, 43

Proximity Check
Displaying the Next or Previous Proximity Check

Violation, 34
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Set Up Proximity Parameters, 7

R
Reference Frame

Drawing a New Reference Frame, 58
Using the Reference Frame Overview, 58
Zooming on the Reference Frame, 56

Relative Origin
Using the Relative Origin, 62

Road Map
Displaying the Wire Wrap Road Map, 44

S
Saving a Log File of Verification Points, 22
Screen Grid

Anchored or Dragged Grid, 59
Fixed or Variable Grid, 60
Turning the Screen Grid On or Off, 59
Using the Screen Grid, 59

Screen Toolbar, 30
Select

Going to the Last Selected Test Point, 53
Selecting a Pad, 52
Selecting a Test Point, 53
Selecting a Test Point or a Pad, 52

Send Us Your Comments, 2
Shortcut Keys

Key Commands Overview, 32
Key Commands Summary List, 65

Shorts
Enter Coordinates of Shorts and Open Points

Manually, 13
Entering Fault Data Overview, 9
Examining Faults Technique, 24
Fault Verification Procedure Overview, 5
Finding the Position of a Selected Pad, 51
Going to the Next Verification Point for the Selected

Error, 50
Set Up Proximity Parameters, 7
Verification Points Table Settings to Properly

Interpret Loadded Verification Points, 20
Show

Choosing What Data to Display, 33
Displaying All Pads or Only Pads with Test Points, 41
Displaying Board Outline Data, 42
Displaying Component Side

Solder Side or Inner Layer Data, 37
Displaying Faults for the Next or Previous Board, 34

Displaying Fixture Grid Points, 42
Displaying Net Numbers, 46
Displaying Silkscreen Data, 41
Displaying Soldermask Data, 41
Displaying Test Point Numbers, 46
Displaying the Fiducials, 45
Displaying the Fixture Drills, 43
Displaying the Fixture Pins, 43
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying the Next or Previous Proximity Check

Violation, 34
Displaying the PCB Data, 37
Displaying the Wire Wrap Road Map, 44
Displaying Verification Points with a Large X, 35
Highlighting a Specific Net, 47
Showing the Job Statistics, 63
Viewing Data in Verify Overview, 33
Zooming to Show All Data, 56

Side Toolbar, 30
Silkscreen

Displaying Silkscreen Data, 41
Software Updates

Download Updates, 3
Solder Side

Active Layer, 38
Displaying Component Side

Solder Side or Inner Layer Data, 37
Flipping the Component Side or Solder Side Data, 39

Soldermask
Displaying Soldermask Data, 41

Spacers
Displaying the Fixture Drills, 43

Statistics
Showing the Job Statistics, 63

Status Bar, 31
Support

Lavenir Technical Support, 2

T
Technical Support, 2
Test Points

Displaying All Pads or Only Pads with Test Points, 41
Displaying Test Point Numbers, 46
Going to a Test Point, 54
Going to the Last Selected Test Point, 53
Moving between a Test Point and Its Grid Point, 55
Selecting a Test Point, 53
Selecting a Test Point or a Pad, 52

Tester Type
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Setting the Tester Error File Format, 8
Toolbar

Application Window, 27, 28
Command Toolbars, 29
Main Toolbar, 29
Screen Toolbar, 31
Side Toolbar, 30
Status Bar, 31

Trace
Going to a Trace, 54

U
Update

Download Updates, 3

V
Variable or Fixed Grid, 60
Verification

Examining Faults Technique, 24
Fault Verification Procedure Overview, 5

Verification Points
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying Verification Points with a Large X, 35
Enter Coordinates of Shorts and Open Points

Manually, 13
Entering Fault Data Overview, 9
Going to the Next Verification Point for the Selected

Error, 50
Import a Fault File from the Tester, 9
Saving a Log File of Verification Points, 22
Verification Points Table Settings to Properly

Interpret Loadded Verification Points, 20
Verify Overview, 1
View

Choosing What Data to Display, 33
Displaying All Pads or Only Pads with Test Points, 41
Displaying Board Outline Data, 42
Displaying Component Side

Solder Side or Inner Layer Data, 37
Displaying Faults for the Next or Previous Board, 34
Displaying Fixture Grid Points, 42
Displaying Net Numbers, 46
Displaying Silkscreen Data, 41
Displaying Soldermask Data, 41
Displaying Test Point Numbers, 46
Displaying the Fiducials, 45
Displaying the Fixture Drills, 43

Displaying the Fixture Pins, 43
Displaying the Next or Previous Fault in the

Verification Table, 33
Displaying the Next or Previous Proximity Check

Violation, 34
Displaying the PCB Data, 37
Displaying the Wire Wrap Road Map, 44
Displaying Verification Points with a Large X, 35
Highlighting a Specific Net, 47
Showing the Job Statistics, 63
Viewing Data in Verify Overview, 33

W
Window

Drawing a New Reference Frame, 58
Using the Reference Frame Overview, 58
Zooming on the Reference Frame, 56

Wire Wrap
Displaying the Wire Wrap Road Map, 44

X
X

Displaying Verification Points with a Large X, 35
X Y Coordinates

Going to Specific X Y Coordinates, 49

Z
Zoom

Zooming on Data Overview, 56
Zooming on the Reference Frame, 56
Zooming to a Specific Zoom Level, 57
Zooming to Show All Data, 56
Zooming Up or Down in Steps, 56


